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FMX1-XL

Based on the fabled DX1 (1983), 
the top-of-the-line sibling to 
the popular DX7, FMX-1 XL 
offers a new and improved take 
on our FMX-1 with the addition 
of new sampled content 
and an expanded selection 
of presets - delivering the 
mighty sounds of one of the 
most prestigious and rare FM 
synthesizers ever produced. 
Outfitted with dual 6-operator 
FM engines each capable of 
16 voices of polyphony, less 
than 150 DX1s were produced 
making it exceedingly 
rare. Our sound designers 
extracted some other-worldly 
sounds from this massive 
instrument, sampling up to 
10 velocity layers per-patch 
in some cases to preserve 
the subtle modulations and 
authentic hardware feeling.

FMX2-XL

A 4-operator variant of its 
big brother based on 3 more 
modest vintage FM synths; 
the DX21 (1985), DS8 (1987), 
and TQ5 (1988). FMX2-XL 
delivers classic vintage FM 
sounds in all of their ‘80s 
glory (both the good and the 
bad!). We utilized the novel 
features of each synth in our 
patch designs, including unique 
unison modes and built-in 
effects which contribute 
heavily to their iconic sound.

FMX-8op

Based on the original 
8-operator FM synthesizer, 
the FVX-1 (1988), FMX-8op 
is a complex and spacious 
sounding instrument with 
detailed modulation, rich 
unisons and a highly-polished 
finish thanks to its fantastic 
built-in effects. Presented in 
a dual-layer design, FMX-
8op offers huge tonal control 
and the ability to easily stack 
patches from multiple synths 
for some truly thick FM sounds.

FMX-4op

A 4-operator variant of the 
FMX-8op, providing deep 
control over sounds from 
iconic ‘80s workhorses like the 
TX81Z (1987), DX100 (1985), 
and more. FMX-4op delivers 
many of the studio classic 
sounds common to pop hits 
of the era, along with new 
sounds inspired by genres of 
today. A dual-layer design 
provides discrete amps, filters, 
modulation and arpeggiators.

FMX-GS

Based on one of the original 
FM keyboards, the GS2, 
FMX-GS offers a unique and 
charactered sound in a neat 
package. One of the most rare 
and vintage of FM synthesizers, 
we fully-restored this model 
(complete with magnet cards) 
and crafted a collection of 
heartfelt sounds to immortalize 
this unique keyboard.

Introduction

FM Suite
A 5-instrument exposé of vintage FM synths

• Huge collection of authentic vintage hardware FM sounds

• Eight FM synthesizers, from common to the ultra-rare

• Explore over 1,000 custom designed presets and create your own

OVERVIEW
FM Suite is a collection of 5 new and updated instruments that deliver the history 

of FM synthesis straight into your DAW. From the sounds of singular instruments 

like the dual 6-operator DX1 and 8-operator FVX-1, to the early GS2, ubiquitous 

DX7, and everywhere in-between, FM Suite gives you a huge range of expertly 

programmed and immaculately sampled vintage FM sounds made with the genuine 

hardware. Explore hundreds of custom-designed presets, quickly edit them with 

modern controls, add high-quality built-in effects, and create unique layered hybrids. 

FM Suite delivers the ultimate collection of authentic vintage FM sounds!

INSTRUMENTS
Each of the 5 instruments in FM Suite provides a detailed sound design 

exposé of an individual or group of vintage FM synthesizers, including a full 

complement of custom designed patches from iconic bass, brass, electric pianos, 

pads, plucks, bells and keys to experimental ambiences, fx and more.

FM Suite delivers an incredible and comprehensive collection of UVI-tailored FM sounds 
covering the gamut of vintage hardware FM synthesizers, from the familiar to the ultra-rare.

Yamaha, DX1, DX21, DX7, FVX1, GS1, GS2, TQ5, TX820, TX816, TX81Z,

V50, Korg and DS8 are trademarks of their respective owners. UVI is 

not affiliated or endorsed by any entities listed here.

Minimum System Requirements

• Latest version of UVI Workstation or Falcon

• 37.37GB of disk space

For more information on the installation process, please 

refer to the document: Soundbank Installation Guide

http://uvi.net/
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
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FMX1-XL - Edit Page

The UI is divided into two pages; [Edit] and [Mod]. Primary controls such as amp, filter, and stereo, and are available on the [Edit] page. Clicking the [Mod] 
button at the top of the interface reveals the second page of controls containing the LFO and Step Modulator.

1  Globals
» Pages

Switch between Edit and Mod page

» Arp on/off

Toggle built-in arpeggiator on/off

2  Amplitude
» ADSR

Typical envelope controls for the amp

» Vel Sens

Adjust the amp velocity sensistivity

3  Filter
» ADSR

Typical envelope controls for the filter

» Vel Sens

Adjust the filter velocity sensitivity

» Filter Type

Multimode filter can be set to low-pass 

(LP), band-pass (BP), or high-pass [HP]

» Depth

Depth of the filters EG

» Cutoff Freq

Filter cutoff frequency

» Resonance

Filter resonance amount

4  Pitch
» Depth

Sets the portamento depth

» Time

Sets the glide time

» Mono

Set FMX1 XL to monophonic mode

5  Effects
» Drive

Adjust drive value

» Crusher

Adjust effect mix amount

» Phaser

Adjust effect mix amount

» Delay

Adjust effect mix amount

» Reverb

Adjust effect mix amount

6  FMIZER
Note: FMIZER is playable via your 

controllers modwheel

» FMIZER

Adjust FM modulation

» Level

FM level amount

» Pitch

Transpose FMIZER by semi-tone

» Velocity

FMIZER velocity sensitivity

7  Modwheel
This section provides a quick way to 

map common controls to your MIDI 

keyboards modwheel

» Vibrato

Speed of the vibrato (free)

» Tremolo

Speed of the tremolo (sync)

» Filter

Cutoff frequency of the Filter

2Amplitude

6FMIZER

1Globals

5Effects

4Pitch

7 Modwheel

3 Filter

http://uvi.net/
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FMX1-XL - Edit Page [continued]

8 Stereo

8  Stereo
» Mode - Off

Sets the stereo mode to OFF (mono)

» Mode - Alt

Sets the stereo mode to ALT; stereo 

position alternates L/R every note, width 

controlled by [SPREAD]

» Mode - Uni

Sets the stereo mode to UNI; layers 

multiple samples and augments them for 

increased stereo presence, modify with 

[COLOR] and [DETUNE]

» Color

Utilizes neighboring samples from the 

library to a unique effect

» Width

Sets the stereo width 

(in ALT and UNI modes only)

» Tune

Detunes the unison layers 

(UNI mode only)

http://uvi.net/
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FMX1-XL - Mod Page

2LFO

1Step Modulator

1  Step Modulator
» Step

Set the number of steps to playback

» Smooth

Interpolates step values for a smooth, 

LFO-like modulation

» Rise

Set the time to activate smooth

» Delay

Set the initial delay time

» Modulation Sequencer

Set the modulation value (draw with 

mouse, double-click to enter explicit 

values) 

» Resolution

Set the step speed/resolution

» Step Mod Routing > Filter

Filter modulation amount

» Step Mod Routing > Volume

Volume modulation amount

2  LFO
» Shape

Select the LFO waveform: Sine, Square, 

Triangle or Sample & Hold (random)

» Sync

Toggle LFO sync to host tempo

» Speed

Adjust the LFO speed

» EG Depth

Depth of the LFO envelope

» Attack

LFO envelope attack time

» Decay

LFO envelope decay time

» LFO Routing > Volume

Volume modulation amount

» LFO Routing > Pitch

Pitch modulation amount

» LFO Routing > Filter

Filter modulation amount

» LFO Routing > Drive

Drive modulation amount

http://uvi.net/
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FMX1-XL - Preset List

Bass

  Bassploitation Wheel

  DX1 Bass Basic

  DX1 Bass Solo

  DX1 Bass Stereo

  EP Bass

  FMized Bass

  Funk Slap

  Harsh Bass

  Industrial

  Puissance

  Roar Bass

  Round Bass 1

  Round Bass 2

  SEM Bass

  Slow Attack Bass

  Soft EBass

  Steady FM Bass

  X-Funky Trash

  Xpress Bass Basic

  Xpress Bass Solo

  Xpress Bass Stereo

Bells

  Bellet

  Capsule

  ChristFMas

  Flexi Bell

  Frantic Bell

  Hard Bellorgan

  Mazing Bells

  Music Crusher Box

  New Wave Tube

  Organic FM Bells

  Road Bell

Brass

  Dirty Brass

  Drive Brass

  FM Brass

  Grandiose

  Horn Section 2 way

  Iconic Brass

  Little FM Brass

  Majestic CS80

  Medium Horns

  Obie FMX

  One BrassX

  Papy Brassard

  Pure Brass

  Riley Brass

  Soft Sweep 1

  Soft Sweep 2

  Syn Brass

  That 80s Brass

  Tight Brass

  Wha Wheel Brass

Keys

  Analog Piano

  CP80 Like 1

  CP80 Like 2

  Dirty Keys

  DX On Road

  DX1 Full Tines

  DX1 Wurly 1

  DX1 Wurly 2

  Dyno Zor

  Electric Organ

  Electric Piano 1

  Electric Piano 2

  EP Attack Noise

  FM Clavinet Clean

  FM Clavinet Dirty

  FM Clavinet Phase

  Full Range

  Haunted Organ

  Hybrid Tines

  Large Chorused

  Medium Tines

  Mega FM Keys Full

  Mega FM Keys Soft

  Pipe Organ Bright

  Pipe Organ Dark

  Power Piano

  Road Bell Road

  Tines Dark

  Wurly Tines

Lead

  80s Brass Lead

  Analog Flute Poly

  Analog Flute Solo

  EP Lead

  Hybrid CS80 Solo

  Organizer FM

  Pure FM Solo

  Soft Moog

  Synth Lead

  Tap Bubblead

  Vibra Lead

  Xpress Attack Lead

Mallet

  Acoustic Mallet

  Acoustic Soft

  Amazing Pluck

  DX1 Vibes

  Major Mallet

  Mysterious Mallet

  Percolate

  Sheeran Imba

  Steel Drums

Orchestral

  Analog Strings

  Bright Strings

  Dark Celli

  Harpsichord 1

  Harpsichord 2

  High FM Strings

  Low Power

  Mello Strings Delay

  Mello Strings Ensemble

  Mid Strings

  Motional Strings

  Nostalgic Strings

  OrchestrHak Full

  OrchestrHak Hard

  Phat and Smooth

  Reverstring

  Sizzle Strings

  Soft Ensemble

  Space Baroque

  Strings Open

  Syn Strings

Pads

  Blue Big Bang

  Darkeys Pad

  Dolipad

  Douceur

  Dream Pad

  FoMinous

  Hak Pad

  Los Car Los

  Low End Pad

  Low Power Pad

  Mohair Pad

  Pad Pluck

  Portatmosphere

  Riley Pad

  Solar Fields

  Space Brightness

  Wave Power Pad

Percs FX

  Clash

  EDrum

  FM Tribal

  Orch Hit

  Percy

  Syndrums

  Tom to Metal

  Wowon Arsh

Pluck

  Almost Seventies

  Dynamic Pluck

  FM Strat Soft

  Fretted Fridge

  Les DX1 Paul

  Noise Guitattack

  Organikeys

  Plastic Harp

  Pluck Pad

  Pop Corn Wheel

  Simili Strat

  Soft Pluck

  Space Guitar

  Synth Acoustic 1

  Synth Acoustic 2

  

Synth

  Complextro

  Dream Poly Short

  Fat 5th Synth

  Fat Wave

  Heavy Synth

  Inter Nate Arp

  Mad Synth

  Poly Attack

  Poly Fusion

  Poly Rotor

  Power Stack 1

  Power Stack 2

  Pure FM Arp

  Son Sale

  Synth Dirt Express

  Synth Dirt Hard

  Tap Bubbles

  Vangelix

  Wave Power

Vocal

  Cheap Synth

  FM Voices

  Men Choirs 1

  Men Choirs 2

  Power Stack Vox

  Synth Choirs

  Vocal Pad

  Vocal Strings

  Vox Crazy Bell

  Vox Tron

http://uvi.net/
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FMX2-XL - Edit Page

The UI is divided into two pages; [Edit] and [Mod]. Primary controls such as amp, filter, and stereo, and are available on the [Edit] page. Clicking the [Mod] 
button at the top of the interface reveals the second page of controls containing the LFO and Step Modulator.

1  Pages
Switch between Edit and Mod page

2  Amp Envelope
Typical envelope controls for the amp

3  Filter Envelope
Typical envelope controls for the filter

4  Effects
» Drive

Adjust drive value

» Phaser

Adjust effect mix amount

» Delay

Adjust effect mix amount

» Reverb

Adjust effect mix amount

5  Arpeggiator
Toggle built-in arpeggiator on/off

6  Filter
» Cutoff Freq

Filter cutoff frequency

» Resonance

Filter resonance amount

» Vel Sens

Adjust the filter velocity sensitivity

» Depth

Depth of the filters EG

» Filter Type

Multimode filter can be set to low-pass 

(LP), band-pass (BP), or high-pass [HP]

7  Noise
» White / Pink

Set noise type

» Amount

Noise level amount

8  Amplitude
» Velocity Sens

Adjust the amp velocity sensistivity

» Vellocity To Attack

Enables Velocity input to Amp Env: Attack

9  Stereo
» Mode - Off

Sets the stereo mode to OFF (mono)

» Mode - Alt

Sets the stereo mode to ALT; stereo 

position alternates L/R every note, width 

controlled by [SPREAD]

» Mode - Uni

Sets the stereo mode to UNI; layers 

multiple samples and augments them for 

increased stereo presence, modify with 

[COLOR] and [DETUNE]

» Mode - HWFX

Enables genuine hardware unison

» Color

Utilizes neighboring samples from the 

library to a unique effect

» Spread

Sets the stereo width 

(in ALT and UNI modes only)

» Detune

Detunes the unison layers 

(UNI mode only)

5Arpeggiator

6Filter

8Amplitude

9Stereo

7Noise

4 Effects

1 Pages

2 Amp Envelope

3 Filter Envelope

http://uvi.net/
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FMX2-XL - Edit Page [continued]

10  Pitch
» Mono

Set FMX2 XL to monophonic mode

» Depth

Sets the portamento depth

» Time

Sets the glide time

11  Modwheel
This section provides a quick way to 

map common controls to your MIDI 

keyboards modwheel

» Vibrato

Speed of the vibrato (free)

» Tremolo

Speed of the tremolo (sync)

» Filter

Cutoff frequency of the Filter

11Modwheel

10Pitch

http://uvi.net/
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FMX2-XL - Mod Page

1Step Modulator

1  Step Modulator
» Modulation Sequencer

Set the modulation value (draw with 

mouse, double-click to enter explicit 

values) 

» Resolution

Set the step speed/resolution

» Steps

Set the number of steps to playback

» Delay

Set the initial delay time

» Rise

Set the time to activate smooth

» Smooth

Interpolates step values for a smooth, 

LFO-like modulation

Steo Modulation Destination

» > Volume

Volume modulation amount

» > Filter

Filter modulation amount

2  LFO
» Sync

Toggle LFO sync to host tempo

» Shape

Select the LFO waveform: Sine, Square, 

Triangle or Sample & Hold (random)

» Speed

Adjust the LFO speed

» EG Depth

Depth of the LFO envelope

» Attack

LFO envelope attack time

» Decay

LFO envelope decay time

LFO Modulation Destination

» > Pitch

Pitch modulation amount

» > Volume

Volume modulation amount

» > Drive

Drive modulation amount

» > Filter

Filter modulation amount

2 LFO

http://uvi.net/
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FMX2-XL - Preset List

Bass

  Clic Bass

  ElecTQ Bass

  EPiano Bass

  Fat Filter

  FM Bassish

  FM Kitch

  Fretted FM

  Jazz Double

  Mini Conic

  Phonky Boss

  Steady House

  Strong One

  Synth Low

  Synthox Bass

  Timpani 21

Bells

  Analog Bell

  Crazy Bells

  Dirty Bells

  Flutty Bell

  Glassy Classy

  Godess Bell

  Hybrid Bell

  Lovely

  Palace

  Pasqual

  Pure FM Bells

  Soft Metal

  Trem Bell

  Tres Jolie

  Twenty One Bell

Brass

  4op Classic Brass

  Brassy Road

  FM Sax

  Fugel 21

  Funky 80s

  Hybrid Brass

  Low Brass

  Medium Brass

  Queen Horns

  Real Sax

  Soft Brass

  Soft DS Brass

  Square Brass

  Steady Horns

  Ultra Soft

  V50 Brass

FX-Perc

  Electric Mallet

  Factory Noise

  Funny Buster

  Goot D0

  House Perc

  Industrial FM

  Kood Baton

  Machine Clap

  Metalittle

  Metalloperc

  Money Drop

  Noisy Pad

  Port Steel

  Scratch

  Syn Snare

  Tom Electric

  Tune Bad

  Walker Shake

  Wood Picker

Keys

  4op Full Tines

  Bass Keys

  Cheap Keys

  ClaV50

  Dark One

  Dyno S8

  FM Reeds

  Hybrid Piano

  Keystalgia

  Little CP

  Noise Road

  Piano Detuned

  Piano Pad

  Pluckeys

  Soft Keys

  Synth Clav

  Synth Harpsi

  Tender Piano

  Tines 21

  TQ Syn Piano

  Vel Clavinet

  Vel Digital

  Vel Piano

  Vibranio

  Wurly 21

  Wurly Trem

Leads

  FM Lead

  Fragilead

  Mayflute

  Op4 Brassy

  Realead Sax

  Sawlo tooth 21

  Square Lead

  TQ Sine

  Ultra Softlo

  Wet Sine

Misc

  Clarinet

  Curtis Mayflute

  Ethnic Synth

  Happy Whistle

  Harmonica

  Hi Vox

  Little Orchestra

  Mell Flute

  Raw Violin

  Siflotin

  Synth Vocals

  Whatever

Organ

  Cheezy Grain

  Churchill

  Classic House

  Click Organ

  Jazz Pop

  La Chapelle 1

  La Chapelle 2

  Moving Organ

  Organ 21

  Tap B3

  TQ Organic

  V50 Organish

Pads

  2op Pad 1

  2op Pad 2

  2op Pad 3

  Fifth Synth

  Low Pad

  Majesty 1

  Majesty 2

  Modulations

  Ominous 50

  Pad Bells

  Pad Sweet

  Sad Fifth

  Saint Phonic

  Sax Pad

  Soft Chorus

  Synth Basic

  Voices Fifty

  Vox Cloud

  X Cosmos

  Zumba Master

Pluck-Mallet

  Breath Pluck

  Celeste

  Chorus Strat

  Digital Benson

  Funky Mute

  Gimmick Pluck

  Malletish

  Mute Guitar

  Pizzetta

  Pluck Drive

  Pluckable

  Pop Cow

  Pop Mallet 1

  Pop Mallet 2

  Space Pluck

  Stick Pluck

  Super Synth

  Synth Harp

  Twenty One Pluck

  Unharmonic

  V50 Hit Pluck

  Vel Pluck

  Xylotronic

  Zither Pluck

Synth

  Chill Stack

  Cindy One

  Cindy Two

  LFOrchestra

  Madison Square

  Munch Akoo

  Overtone

  Pitched Sine

  Poly Funk

  Poly Rub

  Poly V50 1

  Poly V50 2

  Polyvalead

  Power FM Synth

  Random

  Tangerine TV

  Vel Stack

  Vibrant Cello

  Voice Fuzz

  Warm Analog

Waveforms

  21 Pulse

  21 Sawtooth

  21 Square

  Noise

  Saw

  Sine

  Waveform 1

  Waveform 2

  Waveform 3

  Waveform 4

  Waveform 5

  Waveform 6

  Waveform 7

  Waveform 8

  Waveform 9

http://uvi.net/
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FMX-8op - MAIN Page and Globals

Oscillator Edit

Amplitude

Filter

4

5

6

Maste Volume 1

Pages 2

Oscillators 3

Global Controls

1  Master Volume

2  Pages
» Main, Edit, Modulation, Effects and 

 Arpeggiators

Click to change the current control page

Main Controls

3  Oscillator 1 and 2
» Sounds 

Select the OSC 1 and 2 sound

» Volume

Adjudst the OSC 1 and 2 volume

» Pan

Adjudst the OSC 1 and 2 pan

» Power

Turn OSC 1 and OSC 2 on/off

4  Oscillator Edit
» 1 / 2 / 1+2

Select Osc 1 or/and 2; presents discrete 

Signal, Amp Env, Filter and Filter Env 

controls

» Balance

Sets the balance between low and high 

register of the keyboard

» HWFX

Enables genuine hardware unison

5  Amplitude
» Velocity

Toggle velocity on/off

» Vel > Atk

Enables Velocity input to Amp Env: Attack

» ADSR

Adjust the amplitude using a typical 

Attack, Decay, Sustain, Release envelope

6  Filter
» Mode

 Set filter mode (LP/BP/HP)

» Cutoff

Set the filter cutoff frequency

» Resonance

Set the filter resonance amount

» Depth

Set the filter’s depth amount

» Velocity

Set the filter’s velocity sensitivity

» ADSR

Typical ADSR envelope for the Filter 

FMX-8op is outfitted with 2 oscillators; Osc 1 and Osc 2. Both oscillators have independent selection of 175 OSC sounds, dedicated volume, pan, filters and 
envelope generators for amplitude and filter, and arpeggiators in the Arpeggiator page. Edit and Effects pages effect the summed signal of both oscillators 
while Modulation can be set to selectively target Osc 1 and/or 2.

http://uvi.net/
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FMX-8op - EDIT Page

Modwheel

Pitch4

Stereo5

Modwheel3

Oscillator Edit2

1

1  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato Rate, Tremolo Rate and Filter 

Depth

2  Oscillator Edit
Select Osc 1 or/and 2; presents discrete 

controls for Pitch/Portamento and 

Stereo

3  Mode
» Mono

Toggle the voicing mode to Mono

» Poly

Toggle the voicing mode to Poly

» Depth

Adjust the Portamento depth

» Time

Set the Glide time

4  Pitch
» Octave

Adjust the pitch in Octaves

» Semitone

Adjust the pitch in Semitones

5  Stereo
» Mode

Off / Alternate Pan / Unison

» Spread

Change the stereo width

» Detune

Unison layer detune amount 

[Unison mode only]

» Color

Shifts color based on adjacent samples

http://uvi.net/


15

FMX-8op - MOD Page

Step Modulator 1

1  Step Modulator
» Editor

Interactive editor for programming 

sequenced modulations; bar height 

equals mod amount

» Steps

Change the number of playable steps 

(1-16)

» Speed

Change the step duration (1/32 - 1/1)

» Delay

Delay time to activate first step

» Rise

Time to activate step with a smooth 

transition

» Smooth

Interpolates values between adjacent 

steps to smooth parameter modulation 

for a custom LFO effect

Step Modulator Routing

» Oscillator Selector

Set the target oscillator for the 

parameter modulation, Osc 1 and/or 

Osc 2

» Step Modulation Depth

Control the amounts of modulation to be 

applied to various parameters including; 

Volume Amount, Filter Depth

2  LFO
» Waveshape

Choose LFO waveshape; Sine, Triangle, 

Square or Sample & Hold

» Sync

Enable/Disable LFO sync to Host Tempo

» Speed

Change the LFO Speed

» Mode

Change the LFO retrigger mode; 

Retrigger, No Retrigger or Legato

LFO Modulator Routing

» Oscillator Selector

Set the target oscillator for the 

parameter modulation, Osc 1 and/or 

Osc 2

» LFO Depth

Control the amount of LFO modulation 

to be applied to various parameters 

including; Pitch, Volume and Filter

LFO2

http://uvi.net/
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FMX-8op - FX Page

1  Equalizer
» On/Off

Turn the effect on/off

» Gain Low / Mid / High

Adjust the gain boost or cut amount of 

each frequency band

» Frequency

Set the crossover frequency point of 

Low/Mid or Mid/High band

2  Drive
» Power

Turn the effect on/off

» Amount 

 Adjust the drive amount

3  Thorus
» Power

Turn the effect on/off

» Speed 

 Adjust the chorus modulation speed

» Depth 

 Adjust the chorus modulation depth

4  Ensemble
» On/Off

Turn the effect on/off

» Tone 

 Adjust the brightness of the effect

» Mix 

 Adjust the effect mix amount

» Mode 

 Set the ensemble effect mode

5  Phaser
» Power

Turn the effect on/off

» Speed 

 Adjust the phaser modulation speed

» Feedback 

 Adjust the phaser feedback amount

» Depth 

 Adjust the phaser modulation depth

6  Delay
» Power

Turn the effect on/off

» Speed 

 Adjust the delay time

» Feedback 

 Adjust the delay feedback amount

» LoCut 

 Adjust the delay output’s low-cut filter  

 frequency

» HiCut 

 Adjust the delay output’s hi-cut filter   

 frequency

» Mix 

 Adjust the delay effect mix amount

7  Sparkverb
» Power

Turn the effect on/off

» Size 

 Adjust the reverb room size

» Decay 

 Adjust the reverb decay time

» LoDecay 

 Multiplies the decay time (-/+) for the  

 low frequency signal

» HiDecay 

 Multiplies the decay time (-/+) for the  

 high frequency signal

» Mix 

 Adjust the reverb mix amount

Drive 2

Emsemble 4

Thorus 3

Equalizer 1

Phasor5

Delay6

Sparkverb7

http://uvi.net/
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FMX-8op - ARP Page

Step Indicator

Step Editor

7

8

Tie9

Gate6

Link10

Speed5

Octave 3

Steps 4

Power 1

Mode 2

1  Power
Toggle the Arpeggiator On/Off

2  Mode
Select Up, Down, or Up and Down

3  Octave
Set the pitch range in Octaves

4  Steps
Change the number of playable steps 

(1-16)

5  Speed
Change the step duration (1/32 - 1/1)

6  Gate
Change the step length (from zero to the 

tracks Resolution setting)

7  Step Indicator
LED lights up when step is triggered

8  Step Editor
Freely draw note velocities

9  Tie
When active, step inherelts Velocity 

from the previous step

10  Link
When active, Arpeggiator 1 affects 

both OSC-1 and OSC-2 (whereas 

when disabled each Arp modifies its 

corresponding layer only)
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FMX-8op - Preset List

00-Init Mono
00-Init Stereo Unison
00-Init with HWFX

Animated Arp
  Bicephale
  Christmas Synth
  Classic FM Arp
  Delay Hard Pad
  Digital Carpenter
  Double The FM
  Dry Simple
  James Pataya
  Jerry Kahn
  Log A Rtythm
  Miami Slice
  Molassone
  PPG World
  Quarto De Bano
  Raw T Serie
  RIC Sound
  Serpent Tines
  Soft Drink
  Space Hypnose
  Stack Aproach
  Stick Platrember
  Sweep Analogish
  Tangerine DX
  Tic et Tac
  Toys Industry
  Vince The Stone
  Weird Bubbles
  Wheel Birds
  Wheel Log
  Yellow Jacket

Animated Step
  Dancing Steps
  Dark Chemin
  Dual Water
  Magical Leas
  Melody Storsion
  Micro Step
  Moving Bells
  Pan Step
  Parafine
  Psycho Training
  Simple City
  Sombre LFO
  Spinal Vox
  Steady Gate
  Step Immersion
  Submarine
  Try It Legato
  Wheel Me Back

Bass
  _Bass Template Mono
  _Bass Template Poly
  Clip Low
  Digital Pressure

  Electric Chorused
  FM Double Bag
  HWFX Power
  Mix Arp Bass Bell
  Not Only Bass
  One Key Bass Arp
  Paddle Bass
  Parasitarp
  Phat Electric
  Power Bass
  Shaft FM
  Slap FM Bass
  Space Contra
  Stereo Analog
  Syn Slappish
  Zapp Attack

Bells
  _Bells Template
  A Level
  Belle Bell
  Dark Bellor
  Epic Tog RAM
  Exclusive FVX
  Glass FMish
  Globule Bell
  Hammered
  High Layer
  Low Start
  Petite Douceur
  Porta PG
  Quasar
  Simple Analog Bell
  Spider Bell A
  Spider Bell B
  Step By Bells
  Thin and Large
  Unharmonicity
  Very Long One
  Wheel Bell

Brass
  _Brass Template
  Big Orchestra
  Brass Stab HWFX
  Disthorns
  Hybrid Soft Brass 1
  Hybrid Soft Brass 2
  Mallet Brass
  Metal Wind
  Modulated Hard
  Paper Horns
  Processed X
  Pure FVX Brass
  Real Horns
  Revenge Helis
  Space Balkan
  StaccSoft Brass
  Standard FM Section
  Straight Sax
  Synth Brass FM

  Tournier Manege
  Tubass PPG
  Two Brass

Keys
  _Keys Piano Template
  Electric Tines
  FMichelsone
  FVX Clavinet A
  FVX Clavinet B
  HarpsHybrid
  Hypertramp
  Le Clavecin
  My FM Dyno
  Octave Airgebel
  Quite Real One
  The Abbey
  Tines Breath
  Wet Keys
  Wurly Dark
  Yosemite Keys
  Zenitude

Leads
  -Mono Lead Template
  Crash Lead
  Dirty Leading
  Flute Interference
  FM Attack Lead
  FM Calliope
  Fusion Road
  Harsh Lead
  Larsen Lupin
  Lunar Pan
  Motor Lead
  Press Solo
  Saxo Print
  Soft Wheel FX
  Solo Horns
  Space Whistle
  Trombone X
  Vocalead
  Vox Continentalead

Mallet
  African Log
  Happy Whistle
  Mallet Orchestra
  MarimLoop
  Nostalette
  Randomallet
  Short Log
  Space Marimba
  Steel Drumish
  Xylo FM

Organish
  Barbarian Organ
  Electric Bourdon
  Full Church
  Happy Days

  Jolie Church
  Large Cathedral
  Leslie Perc
  Little Caroussel
  Montmartre
  Smooth Organ
  Space Bag Pipe
  Street Organ
  Synth Accordion
  Vox Humana

Pads
  _Pad Template
  Aesthetic
  Dark Pador
  Germanophilia
  Glass Magic
  Horror Pad
  JM I Stop
  Long High Sweep
  Meditation
  Mellow Cotton
  Night in Moscow
  Octaving
  Orchestal Pad
  Pad Pwoblem
  Phaser Classic
  Portamento Glass
  Portougate
  Spacial Time
  Sweep Birds
  Sweep Party
  UVI Filter Pop
  Zoo Logic

Pluck
  Digital Celtic
  Enya Pluckorus
  Exploration
  FM Pure Guitar
  HWFX Dirty Pluck
  HWFX Synth Harp
  Hybrid Expressive
  Kiss Cool
  Low Harp
  Magic Pluck
  Metal Expressivity
  New Agent
  Nylon Sonic
  Phaser Strat
  Pizzicati
  Porta Pluck
  Steady Stack
  Straight Synth
  Wheel Morph Strat
  Zither FM

Polysynth
  Alien Nation
  Cloud Poly
  Digital Funk

  Digital Nylon
  Funky 90s
  Gate Leff Eau
  Generique 80s A
  Generique 80s B
  Glide Time
  Hook Box
  Polead Mania
  Power Dirty
  Raw Sweep
  Synth Machine
  Wet Crunch

Strings
  Classic FM String
  Deep Ensemble
  Pizz Orchestra
  Remark Atto
  Satin Plastic
  Synth Orchestra
  Vaporetto
  Vilvadigital
  Yanni Epic

Voices
  Bulgar Voices
  Choeurs Parasites
  Chrysalide
  Dark Glocken Vox
  Fair Lite
  FM Requiem
  Fragility
  Futachoirs
  Glide Yator
  Harp Mix
  Horns Choir
  Interstellar
  Lunar Calas
  Moving Chorus
  Night Thoughts
  Noise Arty
  Robotetto
  StaccaVox
  Steel Hums
  Stress Choir
  SynthOvox
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FMX-8op - Oscillator Sounds

Bass
  Contra Bass
  Dirty Bass 1
  Dirty Bass 2
  Dirty Bass 3
  EL FM Bass 1
  EL FM Bass 2
  FM Analog
  FM Electric
  FM Slap Bass
  FM Soul
  Funky Balls
  Low Crunch
  Phat One
  Simple Wave
  Standard Electric
  Synth Double Bass
  Tubass

Bell
  Carillon
  Chime
  Digital Bell
  Exclusive FVX
  FM Carillon
  FM Ring
  Glass Bell 1
  Glass Bell 2
  Glocken
  Music Box
  Noisy Bell Attack
  PPG Soul
  Toys Tines
  Vibra Synth

Brass
  Brass Stab
  BrasSwelling
  FM Brass 1
  FM Brass 2
  French Horn 
  Funky Brass
  Large Brass
  Machine Brass
  Mel Horns
  Qwirk Brass
  Saxo Synth
  Section Attack
  Small Section
  Soft Horns
  Synth Brass
  Trombone 1
  Trombone 2
  Trumpet

Keys
  Clavinet
  FM Dyno Hard
  FM Dyno Soft
  Hard Keys
  Harpsichord
  Little Harpsi
  Low Road
  Pianalog
  Road Map
  Simple Piano 1
  Simple Piano 2
  Tines Attack
  Tines Full
  Tines LFO
  Tines Organ
  Wurly Cosmos

Mallet
  African Log 1
  African Log 2
  Caribean
  Gamelan 1
  Gamelan 2
  Gong Tronic
  MarimLoop
  Metal Perc
  Noisy Perc
  Non Harmonic
  Riz de Bol
  Steel Drum
  Syn Balafon
  Ultra Short
  Wood Xylo

Organish
  FM Accordion
  Gospel Organ
  Little Caroussel
  Mello Flute
  Nostalgica
  Organ Sis
  Pan Flute
  Soft FM Organ
  Whistle

Pads
  FFX Evo Pad 1
  FFX Evo Pad 2
  Filter Opening
  Full Brass Pad
  Glass Mania
  Molassone
  Movement
  Pad Full Organ
  Smooth Sweep
  Softy Fluty
  Steady Pad
  Warm Nylon
  Wavetable

Pluck
  Dirty Fret
  El Guitar 1
  El Guitar 2
  FM Harp
  Guitar Age
  Hybrid Strings
  Jazz Guitar 1
  Jazz Guitar 2
  Keystone
  MandoLoop
  Picky Kato
  Synth Harp

Strings
  Full Strings
  Pizzicati
  Soline 1
  Soline 2
  Solo Violin
  Synth Orchestra
  Synth Violin

Synth
  Electric City
  Fifth Element
  FM Synth 1
  FM Waveform 1
  FM Waveform 2
  Lead FO
  Mix Hybrid
  Poly Attack
  Soft Square
  Soft Triangle

Vocals
  Fair VX One
  Female FM
  FVX Choirs
  Haa Choirs
  Low Choirs
  Low Vox
  PPG Vox
  Robot Choir
  Vox 8op
  Vox Analogica
  Vox Box 1
  Vox Box 2
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FMX-4op - MAIN Page and Globals

Global Volume2

Filter7

Oscillators 3

OSC Select 4

Balance 5

Amplitude 6

Pages 1

Global Controls

1  Pages
» Main, Edit, Modulation, Effects and 

 Arpeggiators

Click to change the current control page

2  Global Volume

Main Controls

3  Oscillator 1 and 2
» Power

Turn OSC 1 and OSC 2 on/off

» Sounds 

Select the OSC 1 and 2 sound

» Volume

Adjudst the OSC 1 and 2 volume

» Pan

Adjudst the OSC 1 and 2 pan

4  OSC Select
Select Osc 1 or/and 2; presents discrete 

Signal, Amp Env, Filter and Filter Env 

controls

5  Balance
Sets the balance between low and high 

register of the keyboard

6  Amplitude
» ADSR

Adjust the amplitude using a typical 

Attack, Decay, Sustain, Release envelope

» Velocity

Toggle velocity on/off

» Vel > Atk

Enables Velocity input to Amp Env: Attack

7  Filter
» Freguency

Set the filter cutoff frequency

» Resonance

Set the filter resonance amount

» Depth

Set the filter’s depth amount

» Velocity

Set the filter’s velocity sensitivity

» ADSR

Typical ADSR envelope for the Filter

» Mode

 Set filter mode (LP/BP/HP)

FMX-4op is outfitted with 2 oscillators; Osc 1 and Osc 2. Both oscillators have independent selection of 175 OSC sounds, dedicated volume, pan, filters and 
envelope generators for amplitude and filter, and arpeggiators in the Arpeggiator page. Edit and Effects pages effect the summed signal of both oscillators 
while Modulation can be set to selectively target Osc 1 and/or 2.
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FMX-4op - EDIT Page

Stereo5

OSC Select 2

Pitch 3

Mode 4

Modwheel 1

1  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato Rate, Tremolo Rate and Filter 

Depth

2  OSC Select
Select Osc 1 or/and 2; presents discrete 

controls for Pitch/Portamento and 

Stereo

2  Pitch
» Octave

Adjust the pitch in Octaves

» Semitone

Adjust the pitch in Semitones

3  Mode
» Polyphonic

 Toggle the voicing mode to Poly

» Monophonic

Toggle the voicing mode to Mono

» Portamento: Time

Set the Glide time

» Portamento: Depth

Adjust the Portamento depth

4  Stereo
» Mode

Off / Alternate Pan / Unison

» Spread

Change the stereo width

» Detune

Unison layer detune amount 

[Unison mode only]

» Color

Shifts color based on adjacent samples
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FMX-4op - MOD Page

Step Modulator 1

1  Step Modulator
» Editor

Interactive editor for programming 

sequenced modulations; bar height 

equals mod amount

» Steps

Change the number of playable steps 

(1-16)

» Speed

Change the step duration (1/32 - 1/1)

» Delay

Delay time to activate first step

» Rise

Time to activate step with a smooth 

transition

» Smooth

Interpolates values between adjacent 

steps to smooth parameter modulation 

for a custom LFO effect

Step Modulator Routing

» Oscillator Selector

Set the target oscillator for the 

parameter modulation, Osc 1 and/or 

Osc 2

» Step Modulation Depth

Control the amounts of modulation to be 

applied to various parameters including; 

Volume Amount, Filter Depth

2  LFO
» Sync

Enable/Disable LFO sync to Host Tempo

» Speed

Change the LFO Speed

» Mode

Change the LFO retrigger mode; 

Retrigger, No Retrigger or Legato

» Waveshape

Choose LFO waveshape; Sine, Triangle, 

Square or Sample & Hold

LFO Modulator Routing

» Oscillator Selector

Set the target oscillator for the 

parameter modulation, Osc 1 and/or 

Osc 2

» LFO Depth

Control the amount of LFO modulation 

to be applied to various parameters 

including; Pitch, Volume and Filter

LFO2
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FMX-4op - FX Page

  Equalizer
» On/Off

Turn the effect on/off

» Gain Low / Mid / High

Adjust the gain boost or cut amount of 

each frequency band

» Frequency

Set the crossover frequency point of 

Low/Mid or Mid/High band

  Drive
» Power

Turn the effect on/off

» Amount 

 Adjust the drive amount

  Thorus
» Power

Turn the effect on/off

» Speed 

 Adjust the chorus modulation speed

» Depth 

 Adjust the chorus modulation depth

  Ensemble
» On/Off

Turn the effect on/off

» Tone 

 Adjust the brightness of the effect

» Mix 

 Adjust the effect mix amount

» Mode 

 Set the ensemble effect mode

  Phaser
» Power

Turn the effect on/off

» Speed 

 Adjust the phaser modulation speed

» Feedback 

 Adjust the phaser feedback amount

» Depth 

 Adjust the phaser modulation depth

  Delay
» Power

Turn the effect on/off

» Speed 

 Adjust the delay time

» Feedback 

 Adjust the delay feedback amount

» LoCut 

 Adjust the delay output’s low-cut filter  

 frequency

» HiCut 

 Adjust the delay output’s hi-cut filter   

 frequency

» Mix 

 Adjust the delay effect mix amount

  Sparkverb
» Power

Turn the effect on/off

» Size 

 Adjust the reverb room size

» Decay 

 Adjust the reverb decay time

» LoDecay 

 Multiplies the decay time (-/+) for the  

 low frequency signal

» HiDecay 

 Multiplies the decay time (-/+) for the  

 high frequency signal

» Mix 

 Adjust the reverb mix amount
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FMX-4op - ARP Page

Link10

Gate8

Steps7

Speed9

Mode 5

Octave 6

Power 4

Step Indicator 1

Step Editor 2

Tie 3

1  Step Indicator
LED lights up when step is triggered

2  Step Editor
Freely draw note velocities

3  Tie
When active, step inherelts Velocity 

from the previous step

4  Power
Toggle the Arpeggiator On/Off

5  Mode
Select Up, Down, or Up and Down

6  Octave
Set the pitch range in Octaves

7  Steps
Change the number of playable steps 

(1-16)

8  Gate
Change the step length (from zero to the 

tracks Resolution setting)

9  Speed
Change the step duration (1/32 - 1/1)

10  Link
When active, Arpeggiator 1 affects 

both OSC-1 and OSC-2 (whereas 

when disabled each Arp modifies its 

corresponding layer only)
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FMX-4op - Preset List

00-Init Mono

00-Init Stereo

 

Animated Arp

  Digitarp Vox

  Duality

  Espoir

  FM Zen

  Futuretro Arp

  Groovy Noisy

  Iceland Beauty

  Mallet Arpet

  Modulation Freq

  Nowhere

  Osc Down Arp

  Percussovia

  Pluck Peggio

  PN Wheel

  Raw Mischneider

  Seq Bass Drums

  Simple Efficient

  Space Mambo

  Space Popcorn 1

  Space Popcorn 2

  Sticky Arp

  Sweep Birds

  Tangerine One

  TQool Pad

Animated Step

  Bellspiration

  Blue Kangoo

  Dolce Francia

  Fairlighting

  Gate Happen

  Moving Formant

  Open Bar

  Pad Rico

  Parcel and Pepper

  Power Dark

  Spa Radra

  Step My Bell

  Tower Strass

  Trampolino

  Triangle Snare

  Wave New

Bass

  _Bass Mono Template

  _Bass Poly Template

  Digitalow

  Fretless Land

  Lately Mono

  Lately Stereo

  Noisygital

  One Finger Bass 1

  One Finger Bass 2

  One Finger Bass 3

  One Finger Bass 4

  Op For FM

  Pair of Bass

  Pan Mode

  Panic Onic

  Saturn Wheel

  Slap Road

  Soft Digital

  Stereo Timpani

  Sweep Dream

  Talk Bass

  TQ Mix Bass

  Worldigital

Bells

  _Bells Alt Template

  _Bells Stereo Template

  Annabelle

  Digital Bells

  FX Clochette

  Glasswheel

  Isawheel

  Klippo

  Little Syn Bell

  Merveilleuse

  Mix Bells 1

  Moon China

  Paul Nord

  Pekinoish

  Plastic Bells

  Portobello

  Sine Tree

  Sky Ice

  Tines Texture

  TX Bells

  Xmass Moon

  Xmass Night

Brass

  _Brass Template

  Chill Brass

  Cute Brassy

  Digital Big

  Documentary

  Drive Bass

  Express Noise

  FM Brasses

  Glide Yator

  Meditative Brass

  Modular Brass

  Plastic Horns 1

  Plastic Horns 2

  Saxo Lo

  Soft Dirt Brass

  Solo Syn Trumpet

  Space Attack

  Steady Stab

  Synth Brass 1

  Synth Brass 2

  Xmas Brass

Flutish

  Castelvania

  Digital Blow

  Flute Wide

  Mello In Space

  Polymono

  Shorty Fluty

  Space Flute

  Superbe Noise

  Sweep and Blow

  Tron Teflu

  Weird One

FX

  Broken Cricket

  FX Noise Perc

  Hyper Tunnel

  March of Gnoms

  More Drama

  Noise and Synth

  Pacific Space

  Ramdom Missile

  SAS Huffy

  Siflet Square

  Spacial Cops

Keys

  _Piano Template

  Academic Tines

  Balladigital

  Baroque Mix

  Clavinet 81

  Deep Road

  Double Harpsy

  Hybrid Piano

  Little Dyno

  Oldies Goodies

  Pastel Keys

  Supa Tramp

  Synth 4op Keys

  Together Road

  Toy Piano Dream

  TQ Clavinet

  TX Suitecase

  Upright Dream

  Vibrant Thriller

  Wood  Keys

  Yellow J Clav

Leads

  _Mono Lead Template

  Crunk FMish

  Digital Funk 1

  Digital Funk 2

  Doublead

  Gimmick Brassy

  Noise Solist

  Petit Solo

  Phat Wheel

  Power Lead 1

  Power Lead 2

  Proud Brass

  Screaming Lead

  Sinoisoide 1

  Sinoisoide 2

  Sixties Flavour

  Stapper Lead

  Steady Riley

  Tap Clari

  Ultra Slow

  Wheelarsen Lupin

Mallet

  _Mallet Template

  Creative Mallet

  Dreamallet

  Iconic Mallet

  Interference Log

  Lately Mallet

  Quasibell

  Radical Pan

  Soft FX

  Steel Timpani

Organ

  _Organ Template

  Barbarian Orgue

  Church Organ

  From Organ

  Grandiloquent

  Mignon Organ

  More than Full

  Organ 81Z

  Perc Citon

  Plein Jeux

  Soft Calm

  Space Eglise

  Tron Regan

Pads

  _Pad Template

  Deepmind

  Digital Arp

  Expression

  Fantasia 2019

  Grain Panorama

http://uvi.net/


26

FMX-4op - Preset List

  Groenland

  Harry Bow

  Hyper Sweep

  Large Phase

  Melody Wind

  Multi Sweep

  Orchestal Pad

  Pad Razeet 1

  Pad Razeet 2

  Phase Phase

  Reportage

  Roadmap

  Serious One

  She is False

Pluck

  _Pluck Template

  Aston Pluck

  Chorus Strat

  Dgital Funk

  EPluck Sensation

  Harpish Synth

  Hybridation

  Little Shorty

  Mass Market

  Mono Attack

  Pluck Man

  Pluck Tron

  Rack Phase

  Remarquable

  Short Power

  Soft Mood 1

  Soft Mood 2

  Stack Arp Novice

  Tap Pad 1

  Tap Pad 2

  Tricky Piti

  Vel to Brass

Polysynth

  Daft Poly

  Frantic Mod

  Hook Machine

  Hybrid Organish 1

  Hybrid Organish 2

  Jacket Life

  Lauper Mania

  Layering

  LFO Nic

  Nostalgika

  Polyglote

  Royalty

  Six Board

  Soft Noise

  Stack Rover

  Sweep in Bed

  Synth Gates

  Synth Poly

  TX Power

Strings

  Analog Strings

  Digital Feeling

  Dirty Archet

  Large Ensemble

  Melodic VIola

  Old Movie

  Orchestral FM

  Phase Arper

  Proteiform

  Strings Bubbles

  Tiny Ensemble

  Tron Mood

  VIola Beauty

  Wheel Use

Voices

  Digital Chorale

  Fairfax

  FM Soloist

  Jupiter Land

  Ominous Vox

  Pluck Fair 1

  Pluck Fair 2

  RIChoir

  Voxcello
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FMX-4op - Oscillator Sounds

Bass
  Bow Bass
  Classic 4op Bass
  Diganalog
  Digital Bass
  Digital FM Bass
  Double Bass
  Filter Bass
  FM Funky Bass
  Iconic Bass
  Jazz Bass
  JBass Like
  Little Zap
  MgBass1
  MgBass2
  Moogish
  New Wave
  Picked Bass
  Power 4op Bass
  Road Bass
  Slap 4op
  Square Op
  Talk Bass
  Timpani
  TX Bass

Bell
  Bright Bell
  Carillon
  Christmas
  Glass FM
  Mix Bells
  Nylon Bell
  Reverse Bell
  Synthetic
  Texture
  Very Bell

Brass
  Bra Brass
  Brass Attack 1
  Brass Attack 2
  Brass Fifth
  Brassynth 1
  Brassynth 2
  Brassynth 3
  Breath Horns
  Digi Brass
  Digital Sax
  Horn Ens
  Little Trumpet
  Low Brass
  Middle Horns
  Sax Solo 1
  Sax Solo 2
  Small Section
  Soft Brass 1
  Soft Brass 2
  Tiny Noise Brass

Flutish
  Electric Oboe
  Fake Sax 1
  Fake Sax 2
  Flute Perc
  FM Blow
  FM Clarinet
  FM Flute
  Harmonica
  High Blow
  Hybrid Flute
  Kitch Flute
  Mello Flute
  Noise Flute
  Ocarina
  Perc Whistle
  Recorder
  Wolf Brasson

FX
  Big Machine
  FM Wind
  Ham Factory
  Little Lazer
  Noise Hit 1
  Noise Hit 2
  Noise Winds
  Pigs in Space
  Short Noise
  Synth Bubble
  Tension
  Thrillering

Keys
  Acc Piano 1
  Acc Piano 2
  Clav For Op
  Clavinet 1
  Clavinet 2
  CP FMish
  Dynogital
  Electric FM
  Grain Clav
  Grain Road
  Hard Piano
  Harpsichord
  Piano Stand
  Piano Zyth
  Plain Road
  Syn Dyno
  Synth Wurly
  Tap Tines
  Tines 4op 1
  Tines 4op 2
  Upright Piano
  Vibrant Road

Mallet
  Celeste 1
  Echo Perc
  Gamelox
  Great Vibes
  Little Vibes
  Log A Rhythm
  Metalophone
  Musibox
  Noise Perc
  Tricky Mallet
  Vibraphone 
  Vibrarimba
  Xylo FM
  Xylonoise

Organish
  Bandoneon
  Cheezy Organ
  Church Organ
  Dirty Organ
  Doors Org
  FM Organ 1
  FM Organ 2
  Full Bars
  Grandiose
  Hybrid X
  Little Bourbon
  Organ 81
  Paroisse

Pads
  Analog Sweep
  Analog Voice
  Deep FM
  Dirty Pad
  Drunk Fair Vox
  LFO Pad
  Like a Voice
  Moon Light
  Short Pad
  Square Sweep
  Sweep FM
  Tremolox 1
  Tremolox 2
  Warm Square

Percussions
  Belltree
  FM Snare
  Sifflet
  Space Percs
  Synth Clave
  Triangle

Pluck
  FM Pluck 1
  FM Pluck 2
  FM Sitar
  Grain Pluck
  Harp
  Little Harp
  Muted Guit
  Nail String
  Pluck Malle
  Rack Attack
  Sad Pluck
  Short FM 1
  Short FM 2 
  Steel Guitar
  Tap Guitar
  Unknown Guitar
  Wes Jazz Guit

Strings
  Basic Strings
  FM Cello 1
  FM Cello 2
  High Strings
  Old Movie
  Synth String
  Viola

Synth
  Arp 81Z
  Buzzy Solo
  Clip Lead
  Creep Synth
  Digital Lead
  DX Poly Lead
  FM Poly Power
  FMantasia
  FMoog Lead
  Noise Lead
  Pick a Bull
  Poly Arsh
  Poly Dense
  Power Guitar
  Power Synth
  Sad Synth
  Stack Power
  Stack Synth 1
  Stack Synth 2
  Synth Dist
  Tri Angle

Waveforms
  1Z-Wave1
  81Z-Wave2
  81Z-Wave3
  81Z-Wave4
  81Z-Wave5
  81Z-Wave6
  81Z-Wave7
  81Z-Wave8
  X21 Sine
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FMX-GS - the GUI

2Prorgam

5EQ

1 Volume

4 Voicing

3 Response

6 Tremolo

7 Vibrato

1  Volume

2  Program
Select the sound program and the bank

3  Response
» Velocity

Sets the velocity curve

» Attack

Sets the attack time of the sound

» Release

Sets the release time of the sound 

4  Voicing
Switch between normal and genuine 

hardware detune, ensemble effect

5  EQ
» Bass

Adjust the gain boost or cut amount of 

the bass frequency band

» Mid

Adjust the gain boost or cut amount of 

the middle frequency band

» Treble

Adjust the gain boost or cut amount of 

the high frequency band

6  Tremolo
» On/Off Switch

» Speed

Adjust the speed of the effect

» Depth

Adjust the depth of the effect

7  Vibrato
» On/Off Switch

» Speed

Adjust the speed of the effect

» Depth

Adjust the depth of the effect
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FMX-GS - Preset List

1-Harpsichord I
2-Harpsichord II
3-Harpsichord III
4-Clavichord I
5-Clavichord II
6-Percussive Synth
7-Vibraphones
8-Xylophone
9-Celeste
10-Acoustic Piano I
11-Acoustic Piano II
12-Acoustic Piano III
13-Electronic Piano I
14-Electronic Piano II
15-Electronic Piano III
16-String I
17-String II
18-String Ensemble
19-Electronic String
20-Brass I
21-Brass II
22-Brass III
23-Synth Brass
24-Electronic Organ I
25-Electronic Organ II
26-Pipe Organ
27-Clarinet
28-Steel Drum
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Links

UVI

Home                                                                                     uvi net/ 

UVI Portal                                                                                 uvi net/uvi-portal 

Soundbank Installation Guide                                                         installing_uvi_soundbanks_en pdf 

UVI Workstation User Guide                                                           uviworkstation_user_guide_en pdf 

Your Registered Product Serial Numbers and Download Links                  uvi net/my-products 

FAQ                                                                                       uvi net/faq 

Tutorial and Demo Videos                                                             youtube com/

Support                                                                                   uvi net/contact-support 

iLok

Home                                                                                     ilok com/ 

iLok License Manager                                                                  ilok com/ilm html 

FAQ                                                                                       ilok com/supportfaq 

http://uvi.net/
http://www.uvi.net/
https://www.uvi.net/uvi-portal
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
http://www.uvi.net/dwl.php?p=doc-en
http://www.uvi.net/dwl.php?p=doc-en
http://www.uvi.net/my-products
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